**Assessment of Motor and Process Skills (AMPS) Course Handouts**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMPS Course Schedule</td>
<td>3</td>
</tr>
<tr>
<td>Test and Measurement Statistics Needed to Interpret the Results of an AMPS Observation</td>
<td>7</td>
</tr>
<tr>
<td>Linking Client Baselines to Client-Centered Goals and Interventions</td>
<td>13</td>
</tr>
<tr>
<td>Practice Interview Homework</td>
<td>15</td>
</tr>
<tr>
<td>AMPS Rater Calibration Requirements</td>
<td>17</td>
</tr>
<tr>
<td>AMPS Course Evaluation Form</td>
<td>21</td>
</tr>
<tr>
<td>Giving an AMPS In-Service</td>
<td>23</td>
</tr>
<tr>
<td>OTAP Software License Policy and Information</td>
<td>25</td>
</tr>
<tr>
<td>Draft Letter of Informed Consent</td>
<td>27</td>
</tr>
<tr>
<td>OTAP Right to Privacy Overview</td>
<td>29</td>
</tr>
<tr>
<td>Sample AMPS Results Report</td>
<td>33</td>
</tr>
</tbody>
</table>

**Note.**

Remember to print and bring with you 15 **AMPS Score Forms** and 8 **AMPS Evaluation Worksheets** for your use during the course. The **Evaluation Worksheets** must be printed actual (i.e., 100%) size. Do not scale to fit the paper size.
AMPS Course Schedule

Day One

8:00 – 8:30  1. Participant Registration
8:30 – 9:10  2. Introduction to the AMPS
9:10 – 9:30  **Break**
9:30 – 10:50 3. AMPS Administration Phases I and II – Preparing to Test a Specific Person
10:50 – 12:00 4. Overview of Motor Skills and Adaptation Skills
12:00 – 1:15  **Lunch**
2:25 – 2:45  **Break**
2:45 – 4:20  6. Case Scoring: Kevin, Task F-2, Motor and Adaptation
4:20 – 5:30  7. Overview of Process Skills and Adaptation Skills

**Homework:** Read Chapters 5 and 6 of the AMPS Manual, Vol. 1

**Note.**

We have planned our time carefully, and we will make every effort to adhere to the schedule. You are encouraged to stay until the end of the course on the fifth day so that you may complete the rater calibration. Completion of scoring of all calibration cases is required for rater calibration. Also, please be aware that people vary in the time they take to score. We ask that you be understanding of those who may take more time than you do. If you have completed scoring, feel free to leave the room and return in time for the next session.
**Day Two**

<table>
<thead>
<tr>
<th>Time</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>8:30 – 9:50</td>
<td>1. Case Observation: Virginia, Task F-3, Process</td>
</tr>
<tr>
<td>9:50 – 10:10</td>
<td>Break</td>
</tr>
<tr>
<td>10:10 – 10:40</td>
<td>2. Interpreting the Results of an AMPS Observation and Monitoring Rater Scoring Severity</td>
</tr>
<tr>
<td>10:40 – 12:05</td>
<td>3. Case Scoring: Phyllis, Task B-2, Process</td>
</tr>
<tr>
<td>12:05 – 1:20</td>
<td>Lunch</td>
</tr>
<tr>
<td>2:15 – 2:35</td>
<td>Break</td>
</tr>
<tr>
<td>2:35 – 3:20</td>
<td>5. AMPS Initial Preparation</td>
</tr>
</tbody>
</table>

*Homework:* Read Chapters 7, 8, and 9 of the AMPS Manual, Vol. 1
Day Three

<table>
<thead>
<tr>
<th>Time</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>8:30 – 8:55</td>
<td>1. Interpreting and Documenting AMPS Results: Renia</td>
</tr>
<tr>
<td>8:55 – 10:10</td>
<td>2. Establish the Client-Centered Performance Context and Problems of Occupational Performance, and Case Scoring: Joan, Task C-1, Motor and Process</td>
</tr>
<tr>
<td>10:10 – 10:30</td>
<td><strong>Break</strong></td>
</tr>
<tr>
<td>10:30 – 11:30</td>
<td>3. Discussion of Scores: Joan, Task C-1</td>
</tr>
<tr>
<td>12:20 – 1:35</td>
<td><strong>Lunch</strong></td>
</tr>
<tr>
<td>1:35 – 2:25</td>
<td>5. Discussion of Scores: Joan, Task L-5</td>
</tr>
<tr>
<td>2:25 – 3:15</td>
<td>6. Interpreting the AMPS Results and Planning Intervention: Joan</td>
</tr>
<tr>
<td>3:15 – 3:35</td>
<td><strong>Break</strong></td>
</tr>
<tr>
<td>3:35 – 4:05</td>
<td>7. Plan Live Observation: Issues of Space and Appropriate Task Challenge</td>
</tr>
<tr>
<td>4:05 – 6:30</td>
<td>8. Introduction to Rater Calibration and AMPS Evaluation Worksheets</td>
</tr>
</tbody>
</table>

*Homework: Read Chapters 10, 11, and 12 of the AMPS Manual, Vol. 1*
Day Four – Calibration

8:30 – 9:50  1. Calibration Case: Chris, Task C-1
9:50 – 10:20  Break
11:50 – 1:05  Lunch
1:05 – 3:30  3. Calibration Case: Skip, Task A-2 and Task P-3
3:30 – 3:50  Break
3:50 – 4:30  4. Group Feedback: Skip
4:30 – 5:25  5. Validity and Reliability of the AMPS Measures
4:50 – 5:30  6. Plan for Live Observation: Rater Preparations and Case Details
5:25 – 5:30  7. Review Homework Assignment

Homework: Prepare for Practice Interview

Day Five – Calibration

8:00 – 9:00  1. Practice Interview
9:00 – 9:40  2. Practice Setting Up the Environment
9:40 – 9:55  Break
9:55 – 12:00  3. Calibration Case: Live Observation
12:00 – 1:00  Lunch
1:00 – 1:20  4. Group Feedback: Live Calibration Case
1:20 – 3:20  5. Calibration Case Scoring
3:20 – 3:40  Break
3:40 – 4:00  6. OTAP Software: Installation, Entering Data, and Generating Reports
4:00 – 4:30  7. Rater Calibration Requirements
4:30 – 5:00  8. Returning Home – Integrating AMPS into Practice
5:00 – 5:20  9. Final Thoughts
When an occupational therapist has successfully calibrated as a reliable and valid AMPS rater, he/she is able to use his/her personal copy of the OTAP software to generate ADL motor and ADL process ability measures for a person’s AMPS observation. The purpose of this document is to provide occupational therapists with the information needed to interpret a person’s AMPS results from a norm-referenced perspective. More detailed information about how to interpret AMPS results from both a norm-based and a criterion-based perspective are included in Volume 1 of the AMPS manuals, Chapters 10 and 12 (Fisher & Jones, 2012).

Illustrating the Results of an AMPS Observation

Example ADL motor and ADL process scales are shown in Figure 1. Along the left edge of each scale (ADL motor and ADL process) is a small white arrow. These arrows specify where on the AMPS scales the person’s ADL motor and ADL process ability measures are located. The higher the person’s AMPS measures along the AMPS scales, the more ADL ability he/she demonstrated when observed performing AMPS tasks.

Figure 1. ADL motor and ADL process scales illustrating Renia’s AMPS observation results

To the left of each of the AMPS scales is a vertical bar with a small dot located midway between the top and the bottom of the vertical bar. Those small dots depict the mean (M) ADL ability of a sample of healthy, well persons the same age as the person who was tested (again, mean ADL
motor ability and mean ADL process ability). These means represent the average measure of the age-matched, well standardization sample of the AMPS. The vertical bars extend upward and downward 2 standard deviations (SD) from the mean ADL measure. The normative mean ADL motor and ADL process ability measures for the AMPS are reported in Volume 2 of the AMPS manuals, Chapter 9, Table 9-2 (Fisher & Bray Jones, 2014).

Understanding the Test and Measurement Statistics Needed To Interpret the ADL Motor and ADL Process Ability Measures

More specifically, when a sample of healthy, well, typically-developing persons are tested with the AMPS, their ADL motor and process ability measures are expected to be distributed in the form of a bell-shaped curve (see Figure 2). The majority of the sample’s AMPS measures will be located in the middle part of the bell-shaped distribution, and progressively fewer numbers of the sample’s ADL measures will be located as one moves toward the right (upper) and left (lower) ends of the curve (commonly called tails).

Figure 2. Bell-shaped curve depicting the “normal distribution” of a set of test scores

In the middle of Figure 2 is a long vertical line, located at zero (0) standard deviations (SD). This vertical line represents the mean (M) test score, where M = the sum of all the test scores for all of the well people of the same age in the standardization sample, divided by number of people included in that sample. Thus, the mean can be conceptualized as the average AMPS measure for the age-matched standardization sample.
To the right and left of the long vertical line depicting the mean are additional vertical lines that depict standard deviations from the mean (see Figure 2). Approximately 68% of the age-matched standardization sample of the AMPS would be expected to have AMPS measures within ±1 SD and 95% would be expected to have AMPS measures within ±2 SD (see Figure 2). While the criteria may vary across settings, it is common practice to consider test scores that are within ±2 SD of the normative mean to be “within normal limits”; in some settings, the criterion for indicating need for services may be ±1.5 SD (Richardson, 2010). It is highly unexpected that any person’s AMPS measures would fall above +2 SD. It is also unexpected that the AMPS measures of well persons would fall below -2 SD.

In Figure 3, the normal curve has been superimposed onto the AMPS scales. Here, the relationship between the normal curve and the vertical bars displayed to the right of the AMPS scales becomes clearer. Again, the dots in the middle of the vertical bars correspond to the normative mean (average AMPS measure of the well age-matched standardization sample; see Volume 2, Chapter 9, Table 9-2) and the vertical bars extend upward and downward 2 SD from that mean. This person’s ADL motor and ADL process ability measures are located below the normative range (i.e., below the lower limit of the vertical bars; more than 2 SD below the mean).

![Figure 3](image)

*Figure 3.* Normal curve superimposed on the ADL motor and ADL process scales illustrating Renia’s AMPS observation results

**Interpreting the Results of an AMPS Observation Using Statistical Terms**

ADL motor and ADL process ability measures (in logits) may also be interpreted from a norm-referenced perspective using a variety of statistical terms, including *standardized z scores*, *normalized standard scores*, and *percentile rank*. 
**Norm-referenced findings:** A summary of the results of the AMPS observation is shown in the table below. The ADL motor and ADL process ability measures, expressed in logits, have been transformed into standardized z scores (mean = 0.0, SD = 1.0), normalized standard scores (mean = 100, SD = 15), and percentile ranks (percentage of people with lower AMPS measures).

<table>
<thead>
<tr>
<th>ADL ability measure (in logits)</th>
<th>Standardized z score</th>
<th>Normalized standard score</th>
<th>Percentile rank</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADL motor</td>
<td>-0.3</td>
<td>&lt;3.0</td>
<td>&lt;55</td>
</tr>
<tr>
<td>ADL process</td>
<td>0.8</td>
<td>-2.0</td>
<td>70</td>
</tr>
</tbody>
</table>

The numbers in the table above indicate the following in relation to a norm-based interpretation:

- The ADL motor ability measure was more than 3.0 standard deviations below the normative mean, indicating that >99% of healthy, well people the same age likely have a higher ADL motor ability measure.
- The ADL process ability measure was 2.0 standard deviations below the normative mean, indicating that 97.7% of healthy, well people the same age likely have a higher ADL process ability measure.

*Figure 4. Excerpt from Renia’s AMPS Results Report*

**Understanding the Test and Measurement Statistics Used to Interpret the Results of an AMPS Observation**

All of the test and measurement terms listed above can be defined and understood in relation to the normal curve. That is, each represents a different way to describe where the person’s AMPS measures are located in relation to the mean of the well age-matched standardization sample. **Standardized z scores** are among the most commonly used in occupational therapy. The standardized z score represents the number of standard deviations a person’s AMPS measure is from the normative mean. The mean is set at zero (0 SD) and the standard deviation is set = 1. Thus, the “normal range” would be defined as falling within z = +2 and z = -2 (i.e., within ±2 SD from the mean). If the person’s AMPS measure is equal to the average AMPS measure for the normative sample, the person’s z score will be equal to zero (see the first row of numbers, Standard deviations, located under the normal curve shown in Figure 2). As shown in Figure 3 and Figure 4, Renia’s ADL motor measure fell more than 3 SD below the normative mean (z is < -3.0) and her ADL process measure fell 2.0 SD below the mean.

**Normalized standard scores** are equivalent to z scores. In the AMPS, the mean z score of zero is merely transformed to a normalized standard score of 100. The standard deviation is transformed to an increment = 15. For example, the normalized standard score of an AMPS measure that is more than –3.0 SD below the mean would be <55 (i.e., 3 SD = 3 x 15 = 45; 100 – 45 = 55).

The **percentile rank** describes what percentage of the age-matched normative sample would be expected to have AMPS measures that are the same or lower than the person tested. If a person has an AMPS measure that is average for his/her age, 50% of the normative sample would be
expected to have AMPS measures equal to or lower than that person (see Figure 2). Renia’s ADL motor measure is more than 3 SD below the mean, which means that <1% of the normative sample would be expected to have ADL motor measures at or below hers. Similarly, only 2.3% of the normative sample would be expected to have lower ADL process measures (see Figure 4).

References


Recommended Reading


Linking Client Baselines to Client-Centered Goals and Interventions

Consider how you would plan and implement client-centered and occupation-based interventions based on Joan’s baseline and goals.

**Overall quality of ADL task performance**
- **Cereal and beverage:** Frequent standby physical assistance, imminent risk of a fall, marked physical effort moving wheelchair, and moderately inefficient
- **Ironing a shirt:** Independent, mild safety risk (did not turn off iron), moderate increase in physical effort, and markedly inefficient; shirt only partially ironed

**Client-Centered Goals Related to Improving Quality of ADL Task Performance**
*Joan will prepare simple cold meals (e.g., sandwiches, breakfast) safely and independently, demonstrating only minimal increase in physical effort.*

<table>
<thead>
<tr>
<th>Specific baseline 1</th>
<th>Intervention plan:</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Cereal and beverage: marked physical effort positioning self at workspace and transporting objects (e.g., juice, milk), attempted to move wheelchair with brakes locked</td>
<td>- Objective 1 (subgoal 1): Joan will consistently transport objects independently, demonstrating only minimal increase in effort</td>
</tr>
<tr>
<td><strong>Objective 1 (subgoal 1):</strong> Joan will consistently transport objects independently, demonstrating only minimal increase in effort</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Specific baseline 2</th>
<th>Intervention plan:</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Cereal and beverage: major risk for fall when standing and taking steps to reach for objects from overhead cupboards</td>
<td>- Objective 2 (subgoal 2): Joan will consistently access task objects safely and independently</td>
</tr>
<tr>
<td>- Both task performances: safe when seated in wheelchair</td>
<td></td>
</tr>
</tbody>
</table>

---

**CIOTS**  
Center for Innovative OT Solutions  
Linking Baselines to Goals and Intervention  
September 2018
**Intervention plan** – Given Joan’s baseline and goals, and her ADL process ability measure of 0.2 logit and her ADL motor ability of -0.4 logit, we most likely would recommend environmental modification and caregiver training. What would you suggest in Joan’s case?
Tomorrow, you will be administering an “AMPS” interview to one of the other course participants (and you, in turn, will be interviewed by that other course participant). In order to prepare for this interview, you will need to do the following:

1. Think about your own workplace and the spaces/equipment that you have available. You are to plan with the idea that you will be testing your partner in your own workplace.

2. Use the task descriptions (Vol. 2, Chapter 3) and Vol.1, Chapter 4, Section 4.3 (Pages 4-7 to 4-13) to create a “mini” client-specific AMPS task option list. Select a list of possible task choices that are:
   
a. Possible to use in your own workplace (carefully read Chapter 4, Section 4.3)
   
b. Potentially relevant for the person you will interview (i.e., a course participant) (read Chapter 4, Section 4.4)

   Do not plan to contrive tasks; do not plan to contrive a disability for your partner.

3. Go through steps 1 to 5 (Vol. 1, Chapter 5, Section 5.2.3, Pages 5-8 and 5-9) to determine which final five task choice options to include on your “mini” client-specific AMPS task option list. Use the process task hierarchy (Vol. 2, Chapter 1) to determine the task challenges.

4. Read the task descriptions (Vol. 2, Chapter 3) for each of the five chosen tasks in order to be familiar with the tasks (review Vol. 1, Chapter 5, Section 5.2.6).

5. Add your own version of task notes to your “mini” client-specific AMPS task option list (carefully read Chapter 5, Section 5.2.7), for each of the five tasks you have chosen. You can use Vol. 2 Chapter 2 as a “starting point.” You will need to use your “mini” client-specific task option list (with our task notes included on the list) when you interview you partner.

Note. We will be checking your notes during this session so that we can give you feedback.
AMPS Rater Calibration Requirements

CALIBRATION REQUIREMENTS DEADLINE
All calibration requirements must be completed within 3 months of the last day of the course. Your deadline is included in the e-mail you received with your AMPS OTAP software license and installation information.

YOUR LICENSE KEY FOR OTAP SOFTWARE
Your AMPS license key was sent to you during your course. If you did not receive your license keys, check your SPAM or JUNK folders. If you still cannot locate them, contact CIOTS by e-mail: info@innovativeotsolutions.com.

KEEP YOUR PASSWORD AND YOUR LICENSE KEY CONFIDENTIAL
Allowing others to use your OTAP software password or your license key is a serious violation of national and international client confidentiality laws.

STEP 1: Enter Course Scores
A. Gather your eight AMPS evaluation worksheets. Discarded or lost evaluation worksheets cannot be replaced — you will be required to take the course again.
B. Log into your OTAP software.
   Note. See the OTAP Software Tutorial on the CIOTS website: www.innovativeotsolutions.com/software/tutorial
C. Click Course > AMPS.
D. Select each person/task from the list, matching the name of the person and task to your evaluation worksheet. For example, choose Skip – Tea for Skip’s tea task, not his grooming task!
E. Enter your scores exactly as you marked them in the course. If the faculty changed some of your scores, use those revised scores — do not use your original scores.
F. Click Save.

STEP 2: Test 10 Additional People After the Course
A. Observe ten people performing at least two AMPS tasks each.
B. You must interview and score live observations independently; co-observing, co-scoring, and the use of video recordings are not acceptable.
C. Each person must be at least 2 years of age.
D. At least two (2) people must be healthy, well people; if desired, all of the people you test for rater calibration may be well persons.
E. Obtain written or verbal informed consent from each person you observe, permitting you to send the person’s anonymous evaluation data to CIOTS.

F. You are encouraged to test people performing new, uncalibrated tasks. If you observe someone performing an uncalibrated task, you must observe the person perform three tasks: two calibrated tasks and the one uncalibrated task.

   Note. Your use of new, uncalibrated AMPS tasks supports the calibration and validation of new AMPS tasks. Once a task is calibrated, you will be notified by your OTAP software that a software update is available.

☐ STEP 3: Enter Data for People Tested After the Course

A. Log into your OTAP software.

B. Click Edit > Add New Person.

C. Enter the person’s gender, birth date, and name.

   Note. The option to enter the person’s name is not available when using the program in anonymous mode. If using OTAP software in anonymous mode, be sure to retain the person’s OTAP software ID number and keep it in a secure location according to the established procedures within your work setting (e.g., the security of such procedures which also apply to hard copies of test score forms).

D. Click the checkbox, “Informed consent has been obtained.”

   Note. OTAP software exports calibration data only for people who have given you permission to send their anonymous data to CIOTS.

E. Click Save.

F. Add an AMPS evaluation.

   i. Select the new person.

   ii. Click Edit > Add New Evaluation > AMPS Evaluation.

   iii. Enter the evaluation date — the date of the AMPS observation.

      Note. The person’s age is accurately calculated by the OTAP software only when you accurately enter the person’s birth date and the evaluation date.

   iv. Enter the person’s diagnosis(es) at the time of the AMPS observation.

   v. Select the AMPS tab in the New AMPS Evaluation window.

   vi. Enter the following evaluation data for at least two AMPS tasks:

      • AMPS task name
      • AMPS overall quality of performance (QoP) ratings for effort, efficiency, safety, and independence
      • AMPS item scores

   vii. Enter the person’s AMPS functional level rating at the time of the AMPS observation.

   viii. Enter your AMPS global baseline for the person’s performance (required).
G. Select the **Clusters** tab in the New AMPS Evaluation window (*optional*).
   i. Select clusters of AMPS items that the person did/did not perform effectively
   ii. Enter a specific baseline statement for each cluster
H. Select the **More** tab in the New AMPS Evaluation window (*optional*).
   i. Enter your recommendation(s) based on the AMPS observation
I. Click **Save**.

**STEP 4: Export Calibration Data**
A. Log into your OTAP software.
B. Click **File > Export > Calibration & Revalidation Data > AMPS.**
C. Choose your course type: **In-Person (Live) Course.**
D. Select a location to export your calibration data file — a location where you can find your file later (e.g., your desktop, USB flash drive, hard drive, or network drive).
E. Click **Export** — If your data are incomplete, the program will display a message with common problems. Fix or add the data and export your data again.

**STEP 5: Submit Exported Data File**
A. Visit the CIOTS website: [www.innovativeotsolutions.com](http://www.innovativeotsolutions.com).
B. Click **CORE LOGIN** at the top of the page
C. Log into the Combined Online Resources: Rater Calibration Center (CORe).
D. Under the **Submit your data** section, click **AMPS**
E. Click **Browse** to locate and select your exported data file. If you have trouble finding your data file, repeat Step 4. Ensure that you remember the location of your data file.
F. Click **Upload** to submit your data for analysis.

**Note.** The website will immediately display a message with a confirmation code and the date on which you may acquire the results of your data analyses in the form of data analysis results letters. Data analyses take approximately 1-2 weeks. Refer to Step 6 for downloading your data analysis results letters.

⚠️ If you do not receive immediate confirmation *in your web browser* that all data were received, then CIOTS did not receive your data.

⚠️ Review your data entry for accuracy. It is your responsibility to make sure your data are entered correctly. Errors may result in having to participate in a new course, test additional people, and pay additional fees.

⚠️ It is your responsibility to download your results of your data analysis in a timely manner. Time-sensitive information will be provided in your data analysis results letter.
STEP 6: Download Data Analysis Results

A. Log into the CORE on the CIOTS website: www.innovativeotsolutions.com.
B. If your AMPS data analysis is complete, an AMPS letter will be available under the Download letter section.

Your letter will summarize the results of your data analysis. If the analysis reveals that you have not been scoring the AMPS in a valid and reliable manner, you will be asked to test an additional 10 persons or, in the rare case of extreme (and invalid) rater severity, to take the course again.

Submission of data for an additional 10 persons provides the potential AMPS rater with an additional opportunity to learn to administer and score the AMPS in a valid and reliable manner. Those who do not successfully calibrate for the AMPS with the second set of data must retake the course if they want to use the AMPS in clinical practice or research.

SOME SUGGESTIONS FOR SUCCESSFUL CALIBRATION

• Administer and score the AMPS in a valid and reliable manner.
• Ensure that the observed AMPS tasks are sufficiently challenging.
• Ensure that you score the AMPS items according to criteria in the manual, matching your observations to examples in the manual.
• Before submitting your data, review your data entry for accuracy and ensure that your AMPS item scores and QoP ratings are logical in relation to each other.

Should you have questions, please contact CIOTS by e-mail: info@innovativeotsolutions.com.
AMPS Course Evaluation Form

Your feedback is very important to us because it provides us with important information we can use to plan future courses. As you respond to the following, please try to give us comments that will help us to learn what features to retain or how we should revise future courses.

Course location: ___________________________ Date: ________________

1. What was the best part of the course? Why?

2. What additional information would you have liked to have prior to attending the course?

3. What recommendations do you have to improve the design of the course?

4. Please comment on the quality of teaching of each of the course instructors.

Name (optional): __________________________________________

September 2018
Giving an AMPS In-Service

The following resources are available from the Center for Innovative OT Solutions website, www.innovativeotsolutions.com:
• A PowerPoint presentation that can be downloaded and customized.
• Hints for giving an AMPS in-service presentation
• A complete list of AMPS references that can be printed and distributed.

General considerations:
• Except for the AMPS Score Form, please do not photocopy pages from the AMPS manuals.
• You may photocopy and use any of the AMPS handouts to assist you in your presentation.

Tailoring the presentation to specific audiences:
As with any presentation, one of the first things to consider when preparing is, “Who will be in the audience?” Different groups of people will want different types of information. Clinicians, for example, will want to know about how the AMPS will help them in their daily practice. Researchers and academics will want to know about research supporting the validity and reliability of the AMPS. The information below will help you think about special considerations to modify your in-service for different types of audiences.

Research Colleagues
• Have copies of the AMPS reference list available as a handout.
• Refer them to Chapter 15 of Vol. 1 of the AMPS Manuals (7th revised edition) – validity and reliability studies. Offer to let them borrow your copy, but please do not photocopy the chapter.
• Discuss limitations of existing functional assessments.
• Show the computer-generated AMPS Results Report and explain how it can be used to objectively measure outcomes.

Academicians
• Incorporate the hints above for targeting to an audience of research colleagues.
• Explain that the AMPS is a standardized performance analysis (Vol. 1, Chapter 2), that we can use in conjunction with other methods commonly used by OTs (e.g., task and activity analyses).
• Point out that the AMPS is a complex assessment and that students will need to take an AMPS course to learn to administer and score it.
• If you have given several AMPS evaluations, consider using a case example to demonstrate how the AMPS can be used in the intervention planning process.

Occupational Therapy Clinicians
• Use a case example.
• Show your computer-generated reports.
• Show them how you interpreted the results from norm-based and criterion-based perspectives.
• Discuss how you interpreted the results, planned your intervention, and set goals.

**Clinicians from Related Disciplines**

• Include general information about the unique focus of occupational therapy (the conceptual model can be useful to illustrate this) (Vol. 1, Page 11-3).

• Focus on what occupational therapists can learn about a person’s quality of ADL task performance when we administer the AMPS; and how that information differs, and may compliment, the information we can learn from other assessments.

• Have copies of the AMPS reference list available as a handout.
At the Center for Innovative OT Solutions (CIOTS), we continually strive to provide occupational therapists with the most up-to-date, standardized, psychometrically sound, and occupation-centered assessments. Occupational therapists who are certified in the AMPS, ACQ-OP, School AMPS, ESI, and/or ACQ-SI can enter assessment data and generate reports for each assessment for which they own a current license.

We offer 3-year, 2-year, and 1-year licenses for each of our assessments. When a license expires, the occupational therapist must renew his or her license to continue entering data and generating reports for that assessment. Occupational therapists receive unlimited access to all OTAP software updates and improvements at no additional charge while their OTAP licenses remain current. This ensures that the occupational therapist always has access to the most up-to-date assessment to use with clients.

To ensure uninterrupted use of the assessment, we encourage occupational therapists to renew their OTAP license(s) on schedule so that they are always able to access the software and software-generated reports. As with any assessment, CIOTS considers it the occupational therapist’s personal and professional responsibility to remain informed of manual and software updates. The best way to stay apprised of updates is through our website, www.innovativeotsolutions.com.

OTAP license renewal fees ensure that each occupational therapist who uses the AMPS, ACQ-OP, School AMPS, ESI, and/or ACQ-SI contributes to the continued maintenance and improvement of the OTAP software. For example, OTAP includes new reports and tasks, and continues to work on the latest computer systems, including new versions of Windows 10, macOS, and Linux. CIOTS keeps software license fees as low as possible by distributing software development costs across all OTAP users.

To view an OTAP license expiration date, log in to OTAP and click Help > License. Renew an OTAP license through the CIOTS website, www.innovativeotsolutions.com.

Should you have questions, please contact CIOTS by e-mail: info@innovativeotsolutions.com.
Dear __________________:

I have recently taken a course where I learned how to administer and score an occupational therapy evaluation. The name of the tool is the Assessment of Motor and Process Skills (AMPS), and it is used by occupational therapists to evaluate a person's ability to perform everyday tasks. In order to complete my training, I am required to assess clients as they perform familiar and self-chosen daily life tasks. I must observe each person perform at least two tasks and then score the quality of their performance based on the standardized criteria in the AMPS test manual. I may also ask some questions about the person's perceptions of his/her own performance.

The administration of the AMPS provides me with a tool for planning and implementing occupational therapy intervention. Therefore, I would like to use it as part of my routine occupational therapy evaluation. I would also like your permission to send your anonymous data to the Center for Innovative OT Solutions for evaluation of the quality of my rating of your performance.

If you give me permission to send your data, you will in no way be identifiable. The only information that will be sent to the Center for Innovative OT Solutions is the tasks you performed, your age, your gender, and your diagnoses (if you have any). The AMPS software does not allow me to send your name and official or legal personal identification numbers. Once your data are exported, confidentiality of your data is ensured.

Your signature acknowledges that you have read the information stated and willingly signed this consent form. Your signature also acknowledges that you have received, on the date signed, your personal copy of this document.

_______________________________
Client name – Printed

_______________________________
Client name – Signature

_______________________________
Date

_______________________________
Occupational Therapist – Signature

_______________________________
Date
Occupational Therapy Assessment Package (OTAP)

Client Right to Privacy and Management of Sensitive Personal Information

Purpose of the Occupational Therapy Assessment Package (OTAP):
- OTAP is a software program that enables occupational therapists (OTs) to perform complex analyses of raw test scores in order to
  - Calculate linearized measures of a person’s ability to perform daily life tasks (e.g., activities of daily living, social tasks, and schoolwork tasks)
  - Generate reports that summarize the person’s test results (person’s final measures and how they are interpreted)
- The evaluation tools that are analyzed using OTAP include the Assessment of Motor and Process Skills (AMPS), Assessment of Compared Qualities – Occupational Performance (ACQ-OP), Evaluation of Social Interaction (ESI), Assessment of Compared Qualities – Social Interaction (ACQ-SI), and the School Version of the AMPS (School AMPS)

Why the OTAP Is Critical for Occupational Therapy Practice
- Occupational therapists use OTAP for the following purposes that are critical to their professional role and provision of quality services:
  - Complete the rater calibration process to complete training and certification in order to administer the assessment tool
  - Generate test results used to identify a person’s need for occupational therapy services
  - Use test results to identify what intervention strategies might be most cost effective and beneficial for the person
  - Use test results to evaluate effectiveness of provided interventions, quality assurance, and program evaluation

Considerations Related to Right to Privacy Acts
- **Collection of the least amount of personal information necessary**: Only minimal data necessary for occupational therapy healthcare evaluation and treatment (i.e., generating test results related to the AMPS, ACQ-OP, ESI, ACQ-SI, or School AMPS) is stored in OTAP (see details below)
- **Use of data programs by health care professionals**: Given the occupational therapist’s professional obligation to maintain all information about their clients confidential, right to privacy acts allow for the limited use of data programs by health care professionals when used to store personal information required for provision of professional services
- **Informed consent**: The occupational therapist must obtain informed consent before entering and storing any personal information in the OTAP software
- **Data directly linkable to a living person**: No data directly linkable to a living person (e.g., name, hospital- or government-issued ID number) is stored in OTAP provided it is installed in the anonymous mode
• **Sensitive personal information:** No information is stored in OTAP related to the person’s race, ethnic origin, religious or philosophical views, sexual orientation, political opinions, or membership in professional unions; minimal health-related information is stored (see details below)

• **Installation in anonymous mode:**
  - The OTAP must be installed in an anonymous mode to ensure that the person’s name cannot be stored
  - The installation mode is determined by the person (IT personnel) who installs the program
  - The selected installation mode applies to all end users
  - When the anonymous mode is used, the person is assigned a random OTAP ID number; this OTAP ID number must be retained by the occupational therapist and kept secure according to the established procedures within his or her work setting (the security of such procedures, which also apply to code books and hard copies of test score forms, are judged to be outside the domain of concern that pertains to OTAP security issues)

• **Deletion, correction, and updating of stored data:** All information stored in the OTAP software can be deleted, corrected, or updated when judged to be necessary

• **Data encryption and password protection:** All data stored in the OTAP software are encrypted and password-protected to ensure that only the authorized occupational therapist can access his or her client data; the occupational therapist has a professional obligation to not share his or her password with others, including IT personnel, so as to ensure that all information about his or her clients remains confidential

**Information Stored in OTAP and Reason It Is Required**

• Information stored in OTAP software is insufficient to be connected to a specific person. More specifically, the following information is stored in the OTAP software:
  - **Gender:** required when the age norms differ between genders
  - **Date of birth:** required to enable calculation of norm-referenced scores (i.e., z score, percentile rank, normalized standard score) as well as norm-referenced interpretation of the person’s measure (i.e., determination of whether or not the person’s test results were within the expected range for someone of his/her age)
  - **Date of evaluation:** required to identify when the evaluation was administered and the length of time that has passed between evaluations when tracking a person’s progress/change over time
  - **Global category of the person diagnosis(es), if any** (e.g., Cardiovascular, Developmental disability, Hip fracture/replacement, Schizophrenia, Right-sided cerebral vascular accident): required for rater calibration and certification (e.g., determining if the occupational therapist administers the test in a valid and reliable manner)
  - **Raw test item scores:** required to estimate the person’s measures
  - **Global baseline statement** (e.g., Making a sandwich: minimal effort, moderate inefficiency, independent): required to enable generation of reports
  - **Skills of significance and/or goals:** optional (not required)
  - **Occupational therapy recommendations:** optional (not required)
Information Not Stored in OTAP

- **Person’s name** (when the anonymous mode is used, this information is temporarily entered just prior to generating reports, but is not stored)
- **Person’s overall measure** (i.e., test results)
- **Person’s official identification number** (e.g., the person’s hospital- or government-issued identification number)
- **The specific International Classification of Disease (ICD) diagnostic codes** that apply to the person’s diagnosis(es), if any
- **PDF reports**: test results summaries used for professional purposes (e.g., evaluating need for services, evaluation of progress); these reports are stored in a separate location as deemed appropriate and secure by the user and/or IT personnel

Installation of OTAP and End User License Keys

- In most settings, IT personnel choose to have only one OTAP installation that all users share
- Each occupational therapist has a personal AMPS, ACQ-OP, ESI, ACQ-SI, and/or School AMPS license key that he or she uses to register in the installed application of OTAP
- All end user data are accessed separately by the “owning” occupational therapist, and his or her stored data are password protected
- The location of OTAP software and the OTAP database may be specified, if desired, by the IT personnel

Event Log for IT Personnel

The following events are logged so as to enable IT personnel to monitor end user actions

- End user creation of account (applies to all end users after the single shared application is installed)
- End user name changes
- End user password changes
- Required time intervals for password changes
- Client data export
- Three consecutive failed login attempts; end user is automatically locked out of OTAP
- Database location is moved (IT personnel may specify where data is stored)

For more information, contact

Center for Innovative OT Solutions
4223 S. Mason, Suite A
Fort Collins CO  80525 / USA
e-mail: info@innovativeotsolutions.com
Phone: +1 970 416 8612
The AMPS is a standardized evaluation of a person's ability to perform personal and domestic activities of daily living (ADL) tasks. More specifically, when a person is evaluated using the AMPS, the occupational therapist observes the person perform at least two relevant and chosen ADL tasks. Scoring the AMPS is criterion-referenced, based on how much clumsiness or physical effort, time and space inefficiency, safety risk, and/or need for assistance the person demonstrated when performing ADL tasks. The person's AMPS measures are reported in the table. Their locations are indicated by white arrows on the AMPS scales to illustrate the person's observed quality of ADL task performance.
ADL Process Scale

Expected Range (based on current age: 67 years)

Corresponding Overall Quality of ADL Task Performance Commonly Observed Among Persons with the Same ADL Process Ability

- Highly efficient — timely and spatially very well organized
- Efficient — timely and spatially organized
- Questionable inefficiency/disorganization
- Questionable to mild inefficiency/disorganization
- Mild to moderate inefficiency/disorganization
- Moderate to marked inefficiency/disorganization
- Marked time and/or space inefficiency/disorganization

Summary of Main Findings

ADL tasks observed:
- C-1: Cold cereal and beverage — one person
- L-5: Ironing a shirt — ironing board already set up

Criterion-referenced findings: When compared to criterion-referenced cutoff measures of 2.0 logits on the ADL motor scale and 1.0 logit on the ADL process scale:
- The person’s ADL motor ability measure was below the cutoff and at a level where we would most commonly observe moderate to marked clumsiness and/or increased physical effort or fatigue during ADL task performance.
- The person’s ADL process ability measure was below the cutoff and at a level where we would most commonly observe moderate to marked inefficiency/time-space disorganization during ADL task performance.

Norm-referenced findings: A summary of the results of the AMPS observation is shown in the table below. The ADL motor and ADL process ability measures, expressed in logit, have been transformed into standardized z scores (mean = 0.0, SD = 1.0), normalized standard scores (mean = 100, SD = 15), and percentile ranks (percentage of people with lower AMPS measures).
### Sample AMPS Results Report

#### September 2018

<table>
<thead>
<tr>
<th>ADL Ability Measure (in logits)</th>
<th>Standardized z score</th>
<th>Normalized standard score</th>
<th>Percentile rank</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADL Motor</td>
<td>0.2</td>
<td>&lt;3.0</td>
<td>&lt;55</td>
</tr>
<tr>
<td>ADL Process</td>
<td>-0.4</td>
<td>&lt;3.0</td>
<td>&lt;55</td>
</tr>
</tbody>
</table>

The numbers in the table above indicate the following in relation to a norm-based interpretation:

- The ADL motor ability measure was more than 3.0 standard deviations below the normative mean, indicating that >99% of healthy, well people the same age likely have a higher ADL motor ability measure.
- The ADL process ability measure was more than 3.0 standard deviations below the normative mean, indicating that >99% of healthy, well people the same age likely have a higher ADL process ability measure.

### Specific Findings

**Overall quality of ADL task performance**

- Cereal and beverage: frequent standby physical assistance, imminent risk for a fall, marked physical effort moving wheelchair, and moderately inefficient
- Ironing a shirt: independent, mild safety risk (did not turn off iron), moderate increase in physical effort, and markedly inefficient; shirt only partially ironed

**Specific task-related actions that most reflect diminished quality of ADL task performance**

- **Positions, Moves, Transports, Adjusts:**
  - Cereal and beverage: marked physical effort positioning herself at workspace and transporting objects (e.g., juice, milk); attempted to move wheelchair with brakes locked
- **Stabilizes, Reaches, Walks:**
  - Cereal and beverage: major risk for a fall when standing and taking steps to reach for objects from overhead cupboards
  - Both task performances: safe when seated in wheelchair
- **Notices/Responds, Adjusts:**
  - Both task performances: leaving refrigerator door open and not turning off the iron resulted in health safety risks
- **Heeds, Initiates, Notices/Responds:**
  - Ironing; did not initiate ironing several parts of shirt and did not remove wrinkles from areas she started to iron; shirt not fully ironed

### Client-centered Goals Related to Improving Quality of ADL Task Performance

- Joan will prepare simple cold meals (e.g., sandwiches, breakfast) safely and independently, demonstrating only minimal increase in physical effort
- Joan will consistently transport objects independently, demonstrating only minimal increase in effort
- Joan will consistently access task objects safely and independently

Alexa Johnsson, OT  
Senior Occupational Therapist